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Entering your license key
1. To activate the program, open ReMask and select 
Menu-> Enter Key (bottom left corner). 

2. Enter or copy & paste your 30-digit license key to 
start your trial or activate the program. (Be sure that 
you have not copied any extra spaces).

3. If you are running trial mode, to switch to the full 
version all you need to do is enter your full license key.  
You do not need to uninstall the current software as 
the only difference between the full and trial version is 
the key used to activate the program.

To install ReMask on a second computer, you will need to down-
load Topaz ReMask from topazlabs.com/downloads and then 
enter  your license key. 

Topaz ReMask is a plug-in, which means it won’t run by 
itself and requires a compatible host editor. 

Installation
1. Exit Photoshop or any other image editing program if 
it is open. 

2. Open the Topaz ReMask .dmg or .exe file, double-
click on the Topaz ReMask installer and then follow the 
on-screen instructions. 

3. After installation is complete, open Photoshop and 
ReMask will be located in the Filter menu. 

4. See our FAQ’s (page 56) for additional support. 

Please see our knowledge base at topazlabs.com/sup-
port should you need any additional installation assis-
tance not answered in the FAQ’s.

Important Note:

While the Topaz plug-ins work in a variety of host edi-
tors, ReMask is not compatible with Lightroom, Aper-
ture or iPhoto, as it requires layers and transparency 
to function. Therefore, ReMask will not appear in the 
external editor Fusion Express.

Installation

             Mac Dmg 		          Windows Exe

The Topaz plug-ins require that your image be 8bit or 16bit 
and in RGB mode. The plug-in will be greyed out in the Filter 
menu if your image is not in this mode. To change it, in Ps go 
to Image-> Mode.

Before Topaz ReMask After Topaz ReMask

http://www.topazlabs.com/downloads
http://bit.ly/1rbEt6S
http://bit.ly/1rbEt6S
http://bit.ly/1rbEt6S
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How to install Topaz ReMask in Corel Paintshop Pro 
1. First launch PaintShop Pro.

2. Go to Menu file -> Preferences -> File Locations. 
Select “Plug-ins” from the “File Types” list and click 
“Add”. 

Installation
3. Choose C: \ Program Files \ Topaz Labs \ Topaz Re-
Mask plug-ins and click “OK”. 

4. Topaz ReMask 4 is now available to use.  Simply go 
to Effects -> Plug-ins and select “Topaz ReMask 4    ”.
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Uninstalling
3. Select Programs, then Uninstall a Program.

4. Select Topaz ReMask and click remove. 

Windows 7*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel -> 
Programs -> Programs and Features. 

3. Select Topaz ReMask and click uninstall. 

*Please note that if you also have the 64-bit version of 
ReMask installed, then you will need to first uninstall 
this version before you can uninstall the regular ver-
sion. 

To uninstall Topaz ReMask follow these instructions:

Mac
1. Quit Photoshop (or other editing program).

2. Navigate to Macintosh HD -> Library -> Application 
Support -> Topaz Labs. *To find this, go to your desk-
top and click on Go-> Computer (top menu)

3. Locate the Topaz ReMask file and move it to the 
trash.  You will need to enter your system password 
to OK this change. 

4. Navigate to your Photoshop plug-ins folder located 
at: Applications -> Photoshop -> Plug-ins

5. Locate any leftover Topaz ReMask files and move 
them to the trash. 

Windows XP*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.

3. Double-click on Add / Remove programs.

4. Select Topaz ReMask and click remove. 

Windows Vista*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.

After Topaz ReMask

Before Topaz ReMask
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Introduction
How Does Topaz ReMask 4 Work?
Topaz ReMask streamlines the masking process using a 
new innovative tri-map technique. The tri-map is made 
up of three tones: green, red and blue.  

Users are able to quickly define the elements in their 
image that they want to keep using green; elements 
that they want to cut using red; and elements that they 
want Topaz ReMask 4 to compute using blue. 

Selections are made using the brush tools and then 
Topaz ReMask 4 is able to analyze the user-made selec-
tions and isolate the image subject with precision.

Masking Unveiled
What is Masking?
Masking is the process of isolating a subject or specific 
image elements that you wish to preserve, then erasing 
everything else that you do not want. It is also referred 
to as extraction or cutouts.

What are the benefits of masking?
Masking allows you to take the desired subject and 
elements & cut them out and then merge them into 
another image scene or background. Masking makes 
it easy to change the theme, scene or setting of your 
digital photography subjects. 

Masking is not just for creating composite images;  it 
also makes it possible to adjust only parts of the image. 
For example, selectively increasing saturation, contrast, 
brightness, etc. (also called selective adjustments).

When do I need to mask?
Masking your digital images is ideal when you want to 
remove backgrounds and unwanted detail elements or 
to protect an area of your image from adjustments.

Why do I need Topaz ReMask 4?
Topaz ReMask 4 features easy to use, intuitive tools 
that will save you time and money by simplifying the 
masking process. With Topaz ReMask 4 you can elimi-
nate the busy work of using masks, paths, layer adjust-
ments, selections and eraser tools to isolate a subject 
in your image. 

For video tutorials and other helpful resources 
please visit us at: blog.topazlabs.com/tutorials 
& youtube.com/topazlabs

ReMask Tri-Map

http://www.topazlabs.com/tutorials/remask/
http://bit.ly/1wmznCI
http://bit.ly/1noNqCj
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Topaz ReMask
About Topaz ReMask
Topaz ReMask is a masking and extraction tool that 
makes it easy to extract elements from your digital im-
ages. Isolating an object from a background is typically 
a difficult and time-consuming task, however ReMask  
simplifies the process with its intuitive tools to help you 
quickly make extractions.  

ReMask makes merging multiple image elements 
seamless, giving you ultimate control over creating and 
refining your image scenes.

With Topaz ReMask you can: 

• Easily extract intricate image details

• Quickly isolate areas for selective adjustments

• Make unique compositions

 • Replace backgrounds

• Selectively blur only the background for a simulated 

bokeh effect

• Creatively emphasize the subject easily and naturally 

Primary Functions of Topaz ReMask: 

1. Simplified and lightning-fast masking and extraction.

2. Easily extract highly intricate image details and trans-
parent objects as well.

3. Precise cutting for delicate and complex images like 
hair, fur and tr      ansparent objects (i.e. wedding veils).

4. Preserve edges and other intricate image details. 

5. Make a believable composite that smoothly blends 
multiple images together

Introduction

To connect with other Topaz users, sign up with the Topaz 
Forum online at: www.topazlabs.com/forum

Before Topaz ReMask

After Topaz ReMask

http://www2.topazlabs.com/forum/
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New ReMask 4 Features
Topaz ReMask 4 Features 

1. Updated user interface. With a new and polished design, 
ReMask is now more intuitive and easier to use.

2. Edge Shift detection. This new refining adjustments lets 
you shift the mask edge by a few pixels in either direction.

3. New names for brushes. The brushes from older versions 
have been renamed as follows:
•	 	Basic brush is now Primary brush 
•	 	Single Color Selection brush is now Color Range brush
•	 	Dual Color Selection brush is now Transparency brush

	

4. Speed Boost. Improved and faster speed with the High 
Quality Foreground Recovery algorithm. The Low Quality 
option has been obsoleted.

Introduction

Before Topaz ReMask

After Topaz ReMask

View additional tips and learning resources on our 
blog at blog.topazlabs.com

http://blog.topazlabs.com
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Work Area

Interface (Main View)
The Topaz ReMask 4 interface is straightforward, simple and very easy to use. You’ll be a pro after experimenting for a 
bit.  In order to make sense of the program features and the function of the tools, we have divided the interface into five 
sections:
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Work Area

1

4

2

3

5

1. Preview Navigator

Displays the region of the 
preview image you are 
currently focused on.

5. Split Screen Views

Single, double and quad 
screen options. Also new op-
tion to use checkerboard or 
color background (Keep and 
Cut views only). 

2. Editing Parameters

Displays all of the tools that 
you will need to successfully 
create your mask. 

3. Editing Views 

Displays editing views used
during the masking process. 

4. Preview Window

Displays the preview of 
each editing view. 
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Work Area

Preview Section
The Preview section is the big image on the right that shows you the processed preview of the image. To pan the preview 
image, select the hand tool            (press H  ) and hold the left mouse button on the preview image and drag it around. You 
can also pan your preview image by holding the spacebar key and moving your mouse or by using the red selection box in 
your preview navigator.



12

User Manual
To

pa
z 

 R
eM

as
k

Work Area

Tri-Map Technology
Topaz ReMask uses tri-map technology to create your extraction.  Using the green, red and blue primary brush tools, 
you will define the areas that you want to keep (green), remove (red) and compute (blue).

2. Blue Area (Outline)
The blue painted area represents 
the part of the image that you want 
to compute. When you process your 
image, Topaz ReMask 4 will analyze 
this area to help extract the unwant-
ed background from the desired 
image subject.

1. Red Area
The red area represents the part of the image that you want to remove.

3. Green Area
The green area represents the part of the image that you want to keep.
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Work Area

Views
ReMask 4 gives you five views for viewing your image in the preview section while creating your mask. It also includes split 
screen capabilities, which allows the users to edit in a single, double or quadruple view.   

Mask

Keep

Tri-Map

Original
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Color Range Brushes
These brushes allow you to brush out the foreground 
or background area in your image, based on the color 
selected and the setting of the Color slider.

Color Range
The Color Range slider allows you to determine the 
spectrum of shades affected within the image based 
on the main color selection.   

Transparency Brush
This brush allows you to define two colors (keep/
green and remove/red) to target at once. The Trans-
parency brush is key for images where transparency 
is a factor because it will allow users to select a fore-
ground color, such as the white of a wedding veil, and 
a background color to be removed from behind the 
veil. -> 

Tools
Primary Brushes
The primary (or basic) brush tools allow you to select  
the elements in the image t hat you want to keep 
(green), remove (red) and compute (blue). The primary 
brushes will turn into the Topaz Magic brush after you 
select Compute. Brush sizes range from 1 - 255.

Topaz Magic Brush
The Topaz Magic Brush tool (which becomes available 
after you select “Compute Mask”) allows you to make 
intricate detail eliminations and recoveries to selected 
parts of your image. It will only affect the blue area of 
your initial tri-map. It will not change your original red 
and green selections.

Work Area
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Work Area
General Tools
The general tools include: undo, redo, zoom, selection 
and the hand tool. The selection (square marquee)
tool allows you to select a certain area of your image 
to mask without affecting the areas outside of that 
boundary. 

Fills
The fill tools allow you to fill all of your image or just a 
portion of your image with the selected color.

Reset 
The reset tools allow you to reset your 
entire image to the selected tri-map 
color. Using this feature will erase any 
previous selections made.

Compute
The Compute Mask tool is what will analyze the 
tri-map selections you made and create your image 
mask. 

The Compute Mode gives you the option of selecting 
speed or quality when it comes to processing larger 
images only.  (Change this in your preferences menu by 
checking Enable High Quality Compute.)  Adjusting the 
quality settings will have no affect whatsoever on small 
images.  

Foreground Color

Background Color
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Work Area

	

Refining Adjustments
The refining adjustments will appear only after you 
press Compute to create your mask.

Edge Hardness
Determines how hard your mask is applied to subject 
edges in your image. The higher the parameter the 
harder your edges will be. The lower the parameter, 
the softer (more feathered) your edges will be.

Mask Strength
Determines the brightness of the mask. Increasing 
this parameter will give you more detail by making the 
weaker mask details stronger. 

Edge Shift
Shifts the mask edge by one pixel in either direction.

Recovery (Foreground Color)
Revives the color of your foreground in weaker / more 
transparent areas.  

Desaturation (Foreground Color)
Desaturates the edges of your mask (in weaker / more 
transparent areas) to help with color contamination 
and bleeding. 

Please note: After you make your tri-map selections 
you will need to click on “Compute Mask” for your se-
lections to be analyzed and your mask created. After 
you do that you can make any additional changes or 
refinements to your mask and then click on “OK” 
to fully process your image and save your mask back 
to your host program. Failure to click on “Compute 
Mask” before you select OK will result in your selec-
tions being lost. 
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Enable Brush on Original Image
Allows you to draw on the original image (you will not 
see anything changed on the original image). When 
this option is turned OFF, drawing on the original im-
age will force switch the view to Trimap view. 
 
Enable Sticky Mode for f/b brushes
Allows you to enable the sticky mode for your fore-
ground/background (f/b) brushes. 

Enable Zoom with Mouse Wheel (Mac users only)
Allows user to zoom in using their mouse. May be 
turned off for Mac users with Apple Magic Mouse.

Menu
You can access Topaz ReMask’s menu by clicking on 
the “Menu…” button at the bottom of the interface. 

Preferences
Select this to enable or disable the program tool tips 
or the Auto-Update feature. 

Work Area

Visit the Topaz Labs Blog which features the latest 
Photography, software and design information including 
tutorials, videos, and thoughts about both Topaz and 
non-Topaz topics.

http://bit.ly/1wmznCI
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wEnable Auto-Create Layer
Automatically creates a new image layer for you in 
Photoshop. 

Enable Use Layer Mask
Automatically saves your ReMask extraction back to a 
layer mask. 

Enable Tooltips
Allows you to enable or disable the pop up tips during 
your workflow

Enable Auto-Update
Allows ReMask to automatically check for and down-
load available Topaz ReMask updates. 

Check for Update
Checks for available Topaz ReMask updates. 

Enter Key
Select this to enter your trial or purchased license key. 

Set Background Color
Use Set Background Color option in the menu to 
change the background color on your mask for better 
visibility with several different color palette options. 

NEW! You may also find the background color selection 
option in the upper right corner of the interface next to 
the single, double, and quad screen view options (will 
only be available while in Keep or Cut view modes). 

Work Area
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Save Trimap/Mask
Select this feature to save your trimap/mask currently 
in progress in order to resume editing at a later time. 
The file will be saved as a tiff. You can name the file 
and save it to any safe location on your computer. 

Your saved trimap/mask will appear in this format:

Load Trimap/Mask
Select this feature to load a previously saved trimap/
mask to continue editing on. You must have the 
original image that pairs up with the selected mask in 
order to load it or else you will receive this message:

Work Area

After Topaz ReMask

Before Topaz ReMask
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What’s This?
Select this (or click F1) then click on a feature in the 
Simplify interface to learn more about it. 

Users Guide
Select it for quick access to this user guide.

Tutorials
Takes you to the Topaz ReMask tutorials page where 
you can access additional written and video tutorials 
to help you with your ReMask workflow.

Tech Support
Brings you to the Topaz Labs support page where 
you can request assistance from our support special-
ists, contact our customer service team, retrieve lost 
license keys, or browse through our Knowledge Base. 

Product Info
Select this to go to the Topaz ReMask web page to 
learn more about the Topaz ReMask plug-in.

About
Select this to see what version of ReMask you cur-
rently have.

Work Area

To keep up-to-date with the latest product informa-
tion, special offers, new releases and update notifi-
cations, sign up for the Topaz Monthly Newsletter 
online at: www.topazlabs.com/list/

Before Topaz ReMask

After Topaz ReMask
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Workflow

You can see in the Before and After shots that the original image 
background has been cut out. The parrots have been precisely 
extracted and we were able to add in a new, more deserving back-
ground to liven up the shot. 

In the following steps, we will show you how to achieve these same 
optimal results with your own photos. 

So let’s get started...

Sample Project #1
Beginner Masking Tutorial

In this sample project we will walk you through a basic 
background replacement workflow, step-by-step, to 
help you become more familiar with the ReMask 4 
program. 

For this example we will be using this image of two 
parrots shot against a simple, black background and 
putting them somewhere more eye-catching. By mask-
ing out the background and adding in a tropical one we 
can bring new life to this image!

Before Topaz ReMask After Topaz ReMask
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Workflow

5. Using the Blue Primary Brush, outline the edges of 
your subject that you would like to mask (the blue will 
be the portion of your image that ReMask will analyze). 

 1. Open an image file in Photoshop or whichever host 
edtior you are using that supports layers. 

2. Open ReMask (from the Filter Menu) and navigate 
to Menu-> Preferences. Make sure you have “Auto-
Create-Layer” enabled. You may also choose to have 
“Auto-Create-Mask” checked. Exit out of the program 
and re-enter for these changes to take effect.

3. Re-open ReMask and you’ll notice that it automati-
cally loads to Tri-map view and your image will be filled 
with green. 

4. Select the Blue Primary Brush tool and use the 
brush size slider to select your desired brush size 
or use the [ , ] keys to adjust the size. You may also 
choose to zoom in closer using the + key.
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Workflow

6. Use the red Fill tool to fill the outside of your blue 
selections with red. (The red will be the portion of your 
image that will be cut.)

Your tri-map is now complete and ready to be pro-
cessed!

7. Click on the Compute button to compute your tri-
map and create your mask. 

Here is what your tri-map will turn to after you press 
Compute (this is Mask mode). 
 
Important: After computing your mask, you do not just 
want to press OK. It is important to make additional 
refinements to the mask to get the best results. . 

After computing your 
tri-map selections you 
will notice a new toolset   
that will appear under 
your brushes. This tool-
set is used for refining 
your mask. The Topaz 
Magic brush will also be 
available now. 

Please see page 16 of the user 
guide for a definition of what 
each slider does. 
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8. You can begin refining your image using any of the 
views in the tabs at the top of your interface. 

9. For refinements we also recommend viewing the im-
age in split or quad view mode. 

Workflow

10. When refining, you want to check for areas of gray in the Mask view mode. You can see below that the gray areas in the 
Mask view mode translate over to Keep mode as areas of jagged, unwanted pixels. 

KeepMask
Use the keys 8, 9 
and 0 to switch 
between single, 
double and quad 
screen displays. 

Use the keys 1, 
2, 3, 4 and 5 to 
switch between 
the 5 different 
view modes. 

To change the 
color of the 
background in 
Keep and Cut 
mode, press 
CTRL/CMD + B 
to bring up the 
color palette. 
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Workflow
11. To fix this, you’ll want to work with your Primary 
(basic) brushes with the Magic Brush enabled.  

12. For gray areas in the background (black part of 
mask), use the Red Primary brush and dab on the gray  
pixels...you’ll see that they dissapear with each click. 

 

13. Do the same with the green primary brush, dabbing 
areas of gray  in the foreground (white part of mask).

14. Be sure that you do not break the blue boundary. It 
helps to be in quad view mode for this so that you can 
view your tri-map as you make additional refinements

MaskTri-map

Image Keep

Use the Q & W 
shortcut keys 
to switch back 
and forth be-
tween Green 
Primary and 
Red Primary 
brushes.

Use a brush 
size set a 1-5 
for refine-
ments in small 
areas. 

If you acciden-
tally break the 
blue boundary, 
you can always 
paint it back in. 
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  15. You may also choose to use the Adjustment sliders 
to make additional refinements as desired. 

For this image we will not make any adjustments to the 
Mask Adjustment sliders so that we keep the shape of 
the birds nice and feathery.

We will however, slightly increase the Recovery slider 
under the Color option. This will restore the color 
around the edges of our subject. 

16. Once happy with the selections and after a final 
check of our mask, click OK to process the changes and 
save the masked image back to Photoshop. 

17. Back in Photoshop we can now add in a new back-
ground to finish our image transformation.  

18. Open the background you wish to use. 

19. Now navigate back to your masked image, making 
sure the masked layer is selected. 

20. Press Ctrl/Cmd + A to select the image (you’ll see 
marching ants appear aroun d the boundary) . 

21. Press Ctrl/Cmd + C to copy this selection. 

22. Now navigate back to your background image and 
press Ctrl/Cmd + V to paste that selection. 

23. Press Ctrl/Cmd + T to transform it to fit in with the 
background. 

Workflow

Background Image (Photo © Elan Star)

Masked image back in Photoshop
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Workflow

Before Topaz ReMask

After Topaz ReMask

After Topaz ReMask

Use the dodge & burn tools to lighten or darken the subject’s edges, 
depending on the background used. Since the birds were extracted from a 
black background, the dodge tool was used to lighten the edges around the 
birds where minor black bleeding was apparent on a lighter background. 
You may also choose to zoom in and erase or smooth any leftover flaws. 

In addition, to help the subject blend in with its background, you may need 
to adjust the temperature and tone. Programs such as Topaz Adjust and 
Lens Effects are great for this.
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Sample Project #2
Masking a Tree with the Color Range Brushes

In this workflow we will look at another way to tackle 
the masking process. This workflow makes use of 
ReMask 4’s Color Range Brushes, which come in handy 
for tricky projects like trees, which contain many  
branches and leaves and are typically harder to mask. 

You can see in the Before and After shots on this page 
and the next that the even the most intricate details 
of the tree have been isolated and the old background 
removed.

In the following steps, we will show you how to 
achieve these same creative results with your own 
photos, following this model - which uses color sam-
pling. 

Workflow

Before Topaz ReMask
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Workflow

After Topaz ReMask
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3. Go to the Fill section of your tool panel and click on 
the Blue button. Click on the image to fill it with blue. 

Using the Color Range brushes we will add our Green 
(keep) and Red (remove) selections.

1. Open an image file. 

2. Go to Filter -> Topaz Labs and select ReMask 4. 

When ReMask 4 loads it will automatically open to the 
Tri-map view and your image will be filled with green. 

Workflow
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4. Repeat this process, selecting different colors in the 
background (adjusting the Color Range if necessary) 
and then brush it out. Once a good portion of the 
background is selected in Red, we can move on to our 
Green (keep) selections. 

5. Click on the Green Color Range Brush to activate 
the color picker. Then we will select a color from 
within the tree to be kept. Brush over the tree until it 
is mostly covered. 

3. Click on the Red Color Range Brush. This will au-
tomatically activate the color picker. Using the color 
picker, select part of the background color from 
within the image to be removed.  

You may choose to increase the Color Range slider to 
increase the range of the selected color that will be 
affected in the image. Begin to brush over the image, 
turning the selected color red. 

Workflow

After Red Color Range Brush After Green Color Range Brush

When working with the Color Range Brushes, do not 
zoom in and try to be 100% exact. If you try to get the 
mask perfect, it may not look good after you compute 
it.  As long as there’s some indication of what to keep in 
thinner, tighter areas, the program will know what to do. 

You may also opt to brush in the majority of the 
sky using the Red Primary brush, and then use the 
Red Color Range brush to brush in red closer to the 
boundaries of the branches. 
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Once the Red and Green selections are made using 
the Single-Color Selection brushes,  we have our com-
pleted tri-map. 

6. Click on the Compute Mask button (or Enter key) to 
allow ReMask to analyze the selections and create the 
tri-map. As you can see, ReMask did quite a good job 
extracting the tree from its background:

You can repeat this process as few or as many times 
in your workflow as you would like. The more colors 
that are in your image then the more you will want to 
sample. More color selections will also give you better 
and more precise results once you have computed 
your tri-map, although being 100% precise isn’t neces-
sary. 

Workflow

Mask
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Workflow
To fix bleeding areas of sky, zoom in really close and de-
crease your brush size to 5 or less. Using the red prima-
ry brush, dab areas where you see sky seeping through 
to eliminate it from what is being kept. 

7. For refinements, use the Primary Green and Red 
brushes to make your selections more accurate. In 
Keep mode, change the background color to a dark red 
(or other color) to help you better detect the parts of 
the sky that might be bleeding through still.

Keep
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8. Do the same with the Green and Blue Primary brush-
es for areas of the tree that have been left out. It helps 
to be in double or quad view mode for this so that you 
can refer back to the original image to detect if any part 
of the tree is missing.

Below you can see where there’s a disconnection of 
the white area in the mask, where there should be a full 
branch. 

It’s easiest to refer back to the original image and using 
your Primary Blue brush, click on the original image 
where the part of the branch is missing in your mask 
and it will re-compute. If the area doesn’t entirely come 
back, use the Green Primary brush and dab the missing 
area with short brush strokesw. 

*Before dabbing with green, make sure there is blue 
underneath it (not red). Refer back to the trimap to 
ensure this.

Workflow

Image Mask

Before dabbing in green, be sure there is a blue 
compute underneath the area you want to keep 
(not red).  If you find that part of the tree is red, first 
brush over it with blue, then dab it with green to re-
compute and refine that selection.

Use the hand tool (H or spacebar) to pan around your 
image during the refinment process. Switch between 
the green, red and blue primary brushes using the Q, 
W and E keys. 
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Workflow
9. Make any additional adjustments to the details and 
colors you would like to preserve in your image. 

If you notice any bleeding of the sky coming through 
around the branches, increase the Color Recovery slider 
(under Adjustments) and you’ll notice it diminish. You 
may also choose to shift the Edge Mask one way or 
the other, but make sure to zoom to Fit so you can see 
what it does to the entire image.  

Referring to the tri-map where branches or parts of the 
image may be missing will help you during the refine-
ment process.  

As you can see below, the branches are disconnected 
because there is no green in that area that tells the pro-
gram to keep it (not as noticeable when zoomed out, 
but if being printed larger, this would be a problem).

Dab (not draw) 
with green so 

that the program 
knows to keep 

this area.
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Another way to make refinements is to switch to Cut 
view mode (shortcut key 5). As you can see below, it’s 
now easier to identify what parts of the tree’s branches  
still need work. Again, use the green and blue primary 
brushes to compute and keep.    

10. Make any additional refinements to the details and 
colors you would like to remove from your image and 
save the Mask if you’d like (Menu-> Save TriMap).

11. When you are finished making refinements, press OK 
to return the mask back to your host editor. 

Workflow

Cut



37

User Manual
To

pa
z 

 R
eM

as
k The After image was achieved with the following steps:

(see steps 17-23 on page 26 for how to place your masked image onto 
a new background).

1. Bring the extracted tree into Topaz Clarity. Increase 
the micro, low and medium contrast sliders. Also in-
crease the midtones and shadows sliders. Decrease the  
highlights and high contrast sliders as desired. 

2. Now bring the extracted tree into Topaz Clean and 
apply a Crisp Edge preset to help distinguish the tex-
ture in the tree’s branches and leaves.

3. Back in Photoshop select the background layer (the 
original image you worked with). We are now going to 
edit the background (not the tree).

4. Open Topaz Lens Effects.

5. Expand the Dual Tone filter collection and apply a 
desired preset. 

6. Press ‘Apply’ and then expand the Toy Camera list. 
Apply the ‘Awesomeness I or II’ preset. 

7. Expand the panel on the right side of the screen and 
reduce the camera shake to zero.

8. Press Apply (not OK). 

9. Still in Lens Effects, navigate to the Vignette section 
and apply a vignette to your preferences. 

10. Press OK to return back to your host editor. 

Workflow

Before Topaz ReMask

After Topaz ReMask
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Sample Project #3
Using the Transparency Brush

In this workflow we will look at another way to tackle 
the masking process. This workflow makes use of 
ReMask 4’s Transparency brush, which comes in handy 
for tricky and delicate transparency projects like wed-
ding veils.

You can see in the Before and After shots that the even 
delicate features of the bride’s veil have been pre-
served and the red bricks have been removed. 

In the following steps, we will show you how to 
achieve these same creative results with your own 
photos following this model.

This workflow focuses on two parts:

1. The basic tri-map creation to get the main extraction 
of the couple from the background.

2. The transparency focus to preserve the bride’s veil 
while removing the red brick background.

Workflow

Before Topaz ReMask
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Workflow

After Topaz ReMask



40

User Manual
To

pa
z 

 R
eM

as
k

Workflow
1. Open an image file. 

2. To begin the masking process open Topaz ReMask 4. 

When ReMask 4 loads it will automatically open to the 
Tri-map view and your image will be filled with green. 

3. Outline your subject using the blue primary brush. 
For this example a thin blue line was drawn. 

Tip: Use the zoom buttons (-, +) and hand tool (space-
bar or H) to pan around the image when working with 
a smaller brush size. You may also choose to use the 
preview navigator to maneuver around the image. 

4. Next, use the red Fill tool to fill the background   with 
red (cut). 

5. Click on the Compute button to compute your tri-
map and create your mask. 
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Workflow
Viewing the mask, there a few areas of the it that need 
to be cleaned up. You can fix gray areas using refinment 
techniques as described in the previous two tutorials by 
zooming in and working in quad view mode.  

For areas of gray in the mask’s background (black), 
dab with the red primary brush. For areas of gray in the 
mask’s  foreground (white), dab with the green primary 
brush (don’t worry about the veil just yet). 

v
Mask
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Workflow
Now that the basic tri-map extraction and initial refine-
ments have been completed, we can begin working 
on isolating the bride’s veil and separating it from the 
bricks.

12. Start by selecting the basic blue brush tool and brush 
over the bride’s veil as shown in below.

13. Select your Transparency brush. 

When working with an extensive mask, it is wise to 
save it during your session so you don’t lose your 
work. Simply go to Menu-> Save TriMap. 

To avoid having to  continuously sample colors, go to 
Menu-> Preferences and check “Enable Sticky Mode 
for f/b (foreground/background) brushes. 
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Workflow
13. Select your Transparency brush. You will see a green 
color picker appear. Once you select a color from the 
foreground, a red color picker will then appear for you 
to select a color from the background. 

14. When selecting the keep and remove colors, be sure 
to select the true color values. Instead of clicking on the 
white in the veil, which is contaminated from the red 
of the background, click on the whitest portion of the 
bride’s dress. 

15. The red background is vibrant and pretty consistent 
so we can click just about anywhere in the image to se-
lect it. Just make sure that you do not select a light value 
of red in the highlights of the bricks or else this may 
interfere with the veil.

16. Begin brushing over the veil...the yellow dots that ap-
pear represent transparency. 
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Image

16. After we have finished brushing the keep and re-
move selections in the brides veil click on  the Compute 
button to allow ReMask to analyze the new tri-map 
and create the extraction. 

17. Use the Adjustments sliders as desired to refine 
your mask even further. 

Once the mask refinements are complete, click OK to 
process the image and save it back in Photoshop. 

From there we can add in a new background or make 
any additional image enhancements. 

Workflow

Keep
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Workflow

Before Topaz ReMask
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Workflow

After Topaz ReMask
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restore those details.

Use the Adjustment tools, such as the Color Recovery 
and Edge Hardness to further refine your mask.

Refining Tips
After creating the tri-map, there are several tools avail-
able for refining. Refining allows you to further clean up 
your extraction to help ensure the best, most natural 
looking image possible. 

Please note: Before you can access and use the refining tools you 
will need to create and compute the tri-map. 

For areas that have patches of the background leftover 
(or patches of the foreground missing) you will want to 
use the Magic Brush. 

Select the red Primary brush and then select a small 
brush size and then make short strokes (or click) down 
the refinement area. Each time you make a stroke, your 
image will automatically update reflecting that refined 
selection. 

Select the green brush and recover detail lost by mak-
ing small strokes down the over processed area to 

Workflow
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Merging & Blending
Masking is the hard part, but merging and blending are 
also key parts in making your two (or more)  images 
look like they were made for each other. In this section, 
we will show you how to take your newly masked im-
age and create a whole new scene with a new back-
ground. 

Please note: adding new backgrounds is done in Photoshop 
(or other editing program). This is a quick overview; for additional, 
more in-depth information please refer to your Photoshop user 
guide.

Workflow

To connect with other Topaz users, participate in Topaz 
Contests and to see the latest tips, tricks and tutorials 

sign up for the new Topaz Forum online at:
 www.topazlabs.com/forum

Masked Image (photo © Gary Lamott)                Background Image (photo © Gary Lamott)	                               New creation

http://www.topazlabs.com/forum
http://www2.topazlabs.com/forum/
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Workflow
Merging
We will cover two different ways of merging your im-
ages. 

The first way to merge your two images is by manually 
dragging the new background image into the project 
file that has your mask in it. 

To do this go to File -> Open and select the background 
image you want and then click OK to open it in Photo-
shop.  You will also want to make sure to unlock the 
layer if it is locked before you try moving it.

Using your selection tool (V, Escape) and making sure 
your masked layer is selected, click on the masked im-
age and drag it over to your background layer. 

Make sure the 
masked layer is 
selected in your 
layers panel or else 
you won’t be able 
to drag it over. 
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Next, move to your background layer and press Ctrl/
Cmd + V to paste it. 

Press Ctrl/Cmd + T to re-size the selection, holding the 
shift key down or click on chain            in upper menu to 
maintain proportions while re-sizing. Press Enter when 
finished with the transformation. 

Another way to place a your masked image onto a new 
background is to navigate to your masked image, mak-
ing sure the layer is selected. 

Press Ctrl/Cmd + A to select the layer and Ctrl/Cmd + C 
to copy it. You’ll notice marching ants appear around 
the boundaries. 

Workflow
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Go to Select-> Inverse to invert that selection. Now you 
can begin erasing (for un-straight edges use the Quick 
Selection tool to create a boundary). 

When you’re done, press Ctrl/Cmd + D to remove the 
marquee selection.  

You may also choose to resize the background image. 
To do this, make sure the background image is selected 
in your layers panel. If it’s locked, you’ll need to dupli-
cate that layer (Ctrl/Cmd + J) and then press Ctrl/Cmd + 
T again to resize. 

The lighting is off as the image of the lighthouse was 
taken at an earlier time of the day.  Since the image of 
the moon has darker water, use the eraser tool (E) to 
erase the water from the lighthouse, bringing in darker 
water from the background. 

To avoid erasing the rocks, use the retangular marquee 
tool to drawn a box around it

Workflow
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We now need to darken the lighthouse. The yellow 
tone is nice and compliments the purple sky, however 
the lighting is too bright and looks unnatural. 

Open Topaz Adjust and expand the exposure panel on 
the right side where you can decrease the brightness. 
You may also choose to decrease (or increase) the satu-
ration, change the temperature or anything else that 
you think will help the image blend into its background.

Back in Photoshop, use the burn tool   (         (O) set to 
the highlights. 

Since we want this late-day image to blend in with the 
twilight one, we’ll want to reduce the highlights by 
darkening them with the burn tool.

You may also choose to do this for midtones at a re-
duced exposure. 

Finally, you may choose to work with the background 
image as well. Since the background image was taken 
at night with a high ISO, Topaz DeNoise was used to 
eliminate the noise artifacts. Adjust was then used to 
brighten the image a tad bit and give it a cooler tem-
perature.

Workflow

After Topaz ReMask
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Blending
Blending makes the transition of your masked image 
into your new background image seamless. There are 
many ways and various tools that you can use to do 
this. We will review just a few. 

If desired, you can incorporate the use of any of the 
basic Photoshop tools including: 

Blur Tool - Blurring softens edges and blend transitional 
areas.

Sharpen -Sharpening increases contrast in the painted 
areas.

Smudge - Smudging blends the pixels where you paint 
simulating the action of dragging a finger through wet 
paint.

Dodge Tool - Dodging lightens areas lighter and harden 
edges

Burn Tool - burning darkens areas darker and harden 
edges, 

Sponge Tool - changes the level of saturation of colors 
for an area of an image.

Workflow

Another option for blending and matching colors within 
your masked image and your background image for a 
smoother transition would be to use Topaz Adjust to 
enhance the image exposure, color and saturation. 

You can also use the tools under Photoshop’s Modify option 
to finesse the border of your masked image. You will first need 
to make a selection around the part of the image you want to 
work on before you can access the Modify menu options. 

Border - Takes the border of your selection and turns it into a 
two lined selection with soft edges.
Smooth - Smooths out corners and jagged lines. 

Expand - Enlarges the selection.

Contract - Reduces the selection.

Feather - Feathering gives a smoother fill around the edges of 
your masked image. 
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Glossary
Color bleed (color contamination) - the transfer of color be-
tween nearby objects, caused by the colored reflection of 
indirect light.

Color Decontamination - reduces color cast on the edges of a 
selection.

Color channel – The visual component of a color digital im-
age that represents all the pixels in that picture made up of a 
specific primary color.  For example, in a typical digital photo, 
the primary colors of red, green and blue (from the RGB color 
model) create all the colors in that photo, which may be repre-
sented by three color channels, each of red, green or blue. 

Desaturate - Decreasing the intensity of a color (hue).

Diameter (brush) - Controls the size of the brush. 

Download – The process of transmitting or transferring data 
from one device to another.

Export – Outbound data transfer in a format that can be used 
by other programs.  

Filter Adjustment – Allows you to shift the overall color in an 
image. 

Green Area (Tri-map View) - The active area, which indicates the 
portion of the image that you wish to keep. 

Gradient - The gradient tool creates a gradual blend between 
multiple colors.

Hardness (brush) - Controls the size of the brush’s hard center. 

50% Gray – The undefined area that the computer (Topaz Mask) 
will need to figure out. 

Achromatic - Without color.

Action – A recorded  task that works as an automated memory 
of the enhancement and adjustment steps executed on an 
image.  Once an Action has been recorded it can be invoked 
and reapplied to other images without manually making the 
changes.

Adjustment Layer – A layer that allows you to adjust the look of 
an original image with out making it permanent.  With adjust-
ment layers you can make various changes to a layer without 
damaging it and go back and readjust it at anytime.

Algorithm – Any bit of code or programming that defines a 
process.

Alpha Channel – Photoshop alpha channels are masks through 
which you can apply effects.  The alpha channel is an 8-bit chan-
nel, which means it has 256 levels of gray from 0 (black) to 255 
(white).  An alpha channel lets you save and load selections.

Black Area - The masked area, which indicates the portion of the 
image that you wish to get rid of.

Blue Area  - The undefined area that the computer (Topaz Mask) 
will need to figure out. 

Chroma - Purity or intensity of color.

CMYK – Cyan, magenta, yellow, and black. A color model com-
monly used for 4-color printing by printers to define and mix all 
of the colors they are capable of outputting.
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Glossary
Quick Mask - Allows you to paint on your selection (or the 
masked area).  Then once you have your selection, you can 
delete it, recolor it, mask it, etc.

Red Area - The masked area, which indicates the portion of the 
image that you wish to get rid of.

Refine – Improve (something) by making small changes to make 
it more subtle and accurate. 

RGB – Red, Green, Blue. The color model that is used in digital 
cameras and by computer monitors. 

Saturate - Increasing the intensity of a color (hue).

Tri-Map  – User-generated mask map with three tones: white 
(keep) , black (remove)  and gray (compute) - Mask View or  
Green (keep), Red (remove) and blue (compute) - tri-map 
view. 

Transparency - in reference to a portion of an image that 
is completely invisible (as it has been removed).

White Area (Mask View) - The active area, which indicates the 
portion of the image that you wish to keep.

Import – Inbound data transfer into a file or document.

Layer Mask – An editable selection, attached to a layer that tells 
Photoshop how to deal with the layer that it is attached to.  It 
enables us to get rid of a part of the layer but with the possibil-
ity to go back and edit the result at any time (also called non-
destructive editing).  It in fact blocks part of the layer from ap-
pearing, as if erased, while still being there. Layer Masks provide 
extra flexibility to your Photoshop layers.

Non-Destructive Editing - A form of editing where the original 
content is not modified in the course of editing - instead the 
edits themselves are edited.  This allows for easy adjustments 
and images effects at a later time making photo editing quick 
and flexible.

Opacity – The amount of transparency a layer has.

Pan and Zoom - A useful function that allows users to magnify 
the captured image in the preview and then, by using the cur-
sor, to move or pan around the image.  Typically Pan and Zoom 
allows users to magnify the image 2x or 4x time.  By magnifying 
the images and zeroing in on a specific section, you can see de-
tails not visible when the entire image is sized to fit the preview.

Photo-editing or Imaging software – Programs in which you can 
alter your photos and / or create digital images.  Depending on 
the software, you can improve exposure, color and other attri-
butes of your picture, paint on it, add type, apply special effects, 
remove noise, resize it, combine it with other pictures, prepare 
it for email or posting on the web, output it to a printer or do 
any number of other manipulations or edits. 

Plug-in - Computing (of a module or software) able to be added 
to a system to give extra features or functions.
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“If I use the 30-day trial version will I need to uninstall 
the trial version before I upgrade to a full version?”
No, there is no difference between the trial and full 
version, except for the license key used to activate the 
program. To take yourself off trial mode, simply enter 
your full license key under Menu-> Enter Key.

“Do you have any other ReMask tutorials?”
Yes, we have plenty of tutorial videos on our YouTube 
channel at youtube.com/topazlabs. Also be sure to 
check out our tutorials page at blog.topazlabs.com/
tutorials

“When I fill my red (cut) areas on my tri-map the 
whole image filled with red.”
There is most likely a gap somewhere in blue (com-
pute) outline. The blue outline acts like a barrier in or-
der to ensure accurate masking results.  Use your undo 
button to go back a step then zoom in and pan your 
image to find the opening in your blue outline.  Once 
you locate it, select your blue brush tool and close it 
off.  Then you can select your red flood fill tool and fill 
in the parts of your image that you would like to cut.

I get the error: “You have not selected Compute Mask 
to compute your selections.  Please click OK to go 
back and select Refine Mask. To exit without making 
changes to your image please select cancel.”
This is because your tri-map selections have not been 
analyzed.  You will need to click on the Compute but-

“I need a Topaz ReMask 4 trial key.” 
Visit www.topazlabs.com/checkout for a trial key.

If you need more time to evaluate, please contact us at: 
http://www.topazlabs.com/support  for an extended 
trial key. 
 

 “I can’t find Topaz ReMask 4 in the Photoshop Filters 
menu.” 
For Windows: 
1.	 Please go to your preferences menu in Photoshop 

and select Plug-ins.
2.	 Check/enable the Additional Plug-ins Folder option 

then click Choose.
3.	 After that, please navigate to: C: \ Program Files and 

select the Topaz Labs folder.
4.	 Then click Choose (or it may say Save/OK) to save 

this back to Photoshop.
5.	 Click OK to save your changes, then restart Pho-

toshop. Once Photoshop opens, go to your Filter 
menu and you should be able to access Topaz. 

For Mac: 
1.	 Please go to your preferences menu in Photoshop 

and select Plug-ins.
2.	 Check/enable the Additional Plug-ins Folder option 

then click Choose.
3.	 After that, please navigate to: Computer -> Macin-

tosh HD -> Library -> Application Support and select 
the Topaz Labs folder.

4.	 Then click Choose (or it may say Save/OK) to save 
this back to Photoshop.

5.	 Click OK to save your changes, then restart Pho-
toshop. Once Photoshop opens, go to your Filter 
menu and you should be able to access Topaz. 

Frequently Asked Questions

http://bit.ly/1noNqCj
http://bit.ly/1noNqCj
http://bit.ly/1wmznCI
http://bit.ly/1wmznCI
https://www.topazlabs.com/checkout/
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Are upgrades free? How do I upgrade my software?

Yes, with Topaz Labs upgrades for exisiting purchased 
products are complimentary. To upgrade, all you need 
to do is download the updated software from our 
downloads page at topazlabs.com/downloads and your 
license key will work with the upgraded version.

If using PhotoFXlab or Fusion Express, you’ll need to 
update those programs as well from our downloads 
page. Please make sure that you are exited out of all 
host editors before installing the software. 

How many computers may I install the software on?
You may install the purchased software on up to two 
computers at a time. Simply download the software 
from our downloads page to put it on another comput-
er and use the same license key to activate it. 

I have a question not listed here. 
If you are not able to find the answer here then please 
visit our knowledge base where you can also submit 
a support ticket for additional assistance: www.topa-
zlabs.com/support 

Frequently Asked Questions
ton in order to create your mask.  After that you can 
select OK and process your entire image.

Why doesn’t ReMask appear in Lightroom/iPhoto/Ap-
erture/Fusion Express? 

Topaz ReMask is not compatible with these specific 
programs, as it requires a host editor that supports lay-
ers and transparency. If you do not own a host editor 
that supports layers (e.g. Photoshop, PaintShop Pro), 
we offer a standalone editor, PhotoFXlab, that will 
allow you to use ReMask and can be accessed as an 
external editor in Lr, iPhoto & Aperture. 

How do I place my masked subject on a new back-
ground? 
Once you have extracted your subject and are back to 
your host editor, open up the background you wish to 
place the object on. Go back to your masked image and 
make sure the masked layer is selected in the layers 
panel and then press cmd/ctrl + A to select, and cmd/
ctrl + C to copy that selection. Now switch back to your 
background and press ctrl/cmd + V to paste that selec-
tion. To resize, press ctrl/cmd + T and hold down the 
Shift key to maintain proportions. 

Can I save my tri-map for future use?
Yes, simply go to Menu-> Save TriMap/Mask. When you 
want to re-load it, go to Menu-> Load TriMap/Mask

http://bit.ly/1rbEt6S
http://bit.ly/1rbEt6S
http://bit.ly/1rbEt6S
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Shortcut Keys

Topaz ReMask 4 uses some shortcut keys to speed up your workflow. Many of 
these keys are similar to those in Photoshop. The following keys work at all times.  

Action MAC Shortcut PC Shortcut
Undo CMD + Z CTRL + Z
Redo CMD + Shift + Z CTRL + Shift + Z
Primary Keep Brush (Green) Q Q
Primary Cut Brush (Red) W W
Primary Compute Brush (Blue) E E
Color Range Brush (Green) A A
Color Range Brush (Red) S S
Transparency Brush Z Z
Green Fill R R
Red Fill T T
Blue Fill Y Y
Increase Brush Size ] ]
Decrease Brush Size [ [
Zoom In + +
Zoom Out - -
Zoom to Fit Cmd + 0 (zero) Ctrl + 0
Zoom to 100% Cmd + Alt + 0 Ctrl + Alt + 0

Action MAC Shortcut PC Shortcut
Hand Tool H or spacebar H or spacebar
Marquee Tool M M
Remove Marquee CMD + D CTRL + D
Menu O O
View Original Image 1 1
View Tri-Map 2 2
View Mask 3 3
View Keep 4 4
View Cut 5 5
Compute Mask for tri-map Enter Enter
Process whole image (OK) CMD + Enter CTRL + Enter
Draw Straight Lines Shift + left mouse click Shift + left mouse click
Single Screen View 8 8
Double Screen View 9 9
Quad Screen View 0 0
Set background color Cmd + B Ctrl + B
Save TriMap/Mask Cmd + S Ctrl + S
Load TriMap/Mask Cmd + L Ctrl + L
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Shortcut Keys

 Q	       W                E  A             S Z

54321
098	Ctrl/Cmd 

+ B

         R                    T                    Y

Enter

H or spacebarM

Ctrl/Cmd + Z (Undo)
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Follow us on Twitter (@topazlabs) 
for notifications of recent news and 
easily get in touch with us whenever 
you feel like it!

Find us on our Facebook page and 
network with other Topaz users!

Participate in the entirely user-led 
Topaz Flickr group for a helpful and 
highly active community for Topaz 
Photoshop plug-ins!

Subscribe to our YouTube channel 
to keep up with any newly released 
product video tutorials!

Check out our blog for tutorials, tips 
and updates from Topaz Labs!

And don’t forget to check out our 
other social media outlets including: 
Instagram (@topazlabs), Pinterest, 
LinkedIn and Google+!

http://bit.ly/1oYfBuz
https://www.facebook.com/topazlabs?ref=tn_tnmn
https://www.flickr.com/groups/topaz/
http://bit.ly/1noNqCj
http://bit.ly/1wmznCI
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Topaz Labs LLC, a privately owned company headquartered in Dallas, Texas, focuses on developing advanced image en-
hancement technology. With today’s widespread use of digital still cameras, the need for high-quality digital images has 
greatly increased.  Topaz Labs’ mission is to bring practical state-of-the-art image enhancement technology to both profes-
sionals and consumers.

Contact Information
	
Headquarters
Topaz Labs, LLC 
4100 Spring Valley Road
Suite 103
Dallas, TX 75244

Topaz Labs, LLC
904 West Ave
Suite 102
Austin, TX 78701

Technical Support
Visit: topazlabs.com/support
Email: help@topazlabs.com 

Copyright © 2014 Topaz Labs, LLC. All rights reserved. www.topazlabs.com

http://bit.ly/1rbEt6S
http://www.topazlabs.com/alt
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Be sure to check out the complete line-up of Topaz products. 
Image Plug-ins				  

Go to topazlabs.com/downloads to get your 30-day free trial!

Ultimate control over 
image exposure, 
detail, and color gives 
you the power to 
make your photos 
pop.

Develop unique and 
compelling pho-
tography with the 
most technologically 
advanced software 
available.

Create powerful 
photos & flawless 
image definition. 
Intelligently and 
dynamically enhance 
image contrast.

Specializes in creating 
crisp and stylized 
images. Also features 
extensive smoothing 
capabilities.

Advanced JPEG 
artifact reduction 
filters eliminate JPEG 
compression artifacts 
while preserving im-
age detail like never 
before. 

Advanced high-ISO 
noise reduction tech-
nology that eliminates 
noise while effort-
lessly maximizing and 
retaining image detail.

Output & creative 
sharpening with three 
levels of intricate 
and specific detail 
enhancement.

The superior capture-
sharpening solution 
that actually recovers 
lost detail and refines 
with micro-contrast 
detail enhancement.

Your virtual camera 
bag of effects simu-
lated from real lenses 
and filters. Effects in-
clude creamy bokeh, 
old school filters and 
more!

Remove unwanted 
backgrounds from 
your digital images 
quickly and easily with 
ReMask. 

Expand your creativity  
alter your image’s 
look by applying one 
of over a thousand 
color filters.

Transform your 
regular photo into a 
beautiful work of art,  
such as an oil painting, 
watercolor, line & ink 
drawing and more!

Create beautifully 
rendered and natural 
lighting effects in 
seconds!

Our standalone editor 
that is a one stop 
workshop for access-
ing all of your Topaz 
plugins. Can also work 
as an external editor 
(replacing Fusion). 

Our free external edi-
tor required to use To-
paz Labs in Lightroom, 
iPhoto and Aperture. 
PhotoFXlab can be 
used in its place as the 
external editor.

http://topazlabs.com/downloads

